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Helpful Prerequisites

Introductory Course Additional Resources

This course does not require any 1. Estimating the Properties of
prerequisite courses. However, Chemicals (video)

general knowledge of physical 2. Estimating the Properties of
property estimation, chemical Mixtures (video)

structures and computer
applications is expected.
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https://www.youtube.com/watch?v=nF9V4ee-N80
https://www.youtube.com/watch?v=x1hMTVnfNpI

Topics Presented

Common Operations

This course presents several terms
and operations that are repeatedly
used throughout Cranium and
Synapse. These operations include
navigation, editing data values,
copying and pasting values, choosing
units of measure, changing number
formatting and printing.

Basic Terminology
Navigation

Adding and Deleting Pages
Editing Property Values
Editing Special Characters
Editing All Data Values
Copying and Pasting Values
Choosing Units of Measure
Number Formatting

Printing




Create a Working Copy

The actions taught in this course will
permanently change the contents of

B MKSTest - MKS Core Knowledge Base - Workmkskbd
File Edit MNavigation Bookmarks Commands Window Options Help

the database file being used. It is highly
recommended that a ‘working copy’ of
a knowledge base be used.

To create a working copy, open a
knowledge base and then select the
Save a Copy command from the File
menu. Enter a name for the working
copy. Open and use the working copy
once the copy operation is complete.

Molecular Knowledge Systems 2018-11-28

MNew... Ctrl+N

Open... Ctrl+0
Close

Save a Copy...

Compare Documents...
Conveft Document...
Import Yalues...

Save a copy of a knowledge base
to be used for practice and
experimentation.




Terminology: Document Window Structure

Document windows are divided into

several sub-windows called panes. A
typical window contains the following

panes:

1.

2.
3.
4

Chapters Pane
Identifier Pane
Data Pane

Status Pane

# MEKS Core Knowledge Base - Internal mkskbd E\@
7 N\
Summary Chemi(&l/)ﬂixtures \< Techniques\< Groups \< Elements \< References
/ N\

ITriﬂuoroiodomethane

CaEs 5B

A2

Chemical Structure Section

[
|
F—C—F

Similar Chemical Section

\ Page: 411 of 2548

@ BM: - -

Molecular Knowledge Systems
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Terminology: Reference Book Analogy

¥ MKS Core Knowledge Base - . — = 5
—— —

M\/ Chemicals [/ Mixtures \< Techniques\< Groups \< Elements \< F!eferjkes

= —

Documents are prese nted in a fo rm at Methanol + Methyl benzoate
analogous to a printed reference CompositionTemperature Dapendent Section
b 0]0) k : Property: | Density, Liquid - f(T.X) Data Values

Temp X,1: Methanol X,2: Methyl benz... X, 3 Data
c | wt % | wt % | w| glcm3
=, . 1 | 25.000000 1.139754 98.860246 --- 1.079600 R
1. Documents are divided into P P e N [T
h 13 | 25.000000 5.661916 94.338084 - 1.062800
C a pte rS 4 | 25.000000 8.180155 91.819845 --- 1.052970
. 15| 25.000000 12.531266 87.468734 --- 1.036790
2 . C h a pte r‘s CO nta | n p a ge S . 16| 25.000000 13.723549 86.276451 R 1.032550
|7 | 25.000000 19.354953 80.645047 - 1.013270
. '8 | 25.000000 26.139242 73.860758 - 0.990920 v
3. Each page contains data and < >

attributes about a single entity. e

1 05E+0 — u
iy

1.02E+0 — -
e | —_ = &

| ( Page: 1 of 438 ) BM: - - -

\/
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Terminology: Entities

Cranium and Synapse and their
documentation often use the term
“entity” to refer to the objects used in
each application. Examples of entities
are shown in the lists to the right.
Entities are typically displayed in
document chapters.

Entity Examples

Combinatorial Design
Graphical Design
Triangular Graph
Technique

Reference

Chemical

Bookmark

XY Data Set
XY Graph
Function
Element
Mixture
Report

Group

Molecular Knowledge Systems

2018-11-28




Navigation: Terminology

Document windows are divided into

several sub-windows called panes. A
typical window contains the following

panes:

1.

2.
3.
4

Chapters Pane
Identifier Pane
Data Pane

Status Pane

# MEKS Core Knowledge Base - Internal mkskbd E\@
7 N\
Summary Chemi(&l/)ﬂixtures \< Techniques\< Groups \< Elements \< References
/ N\

ITriﬂuoroiodomethane

I

Chemical Structure Section

©,

Similar Chemical Section

\ Page: 411 of 2548

@ BM: - -

Molecular Knowledge Systems
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Navigation: Chapters and Pages Chapters

#MKSCore KnW \E@

— L —
Sumgai \< Chemicals / Mixtures /\< Techniques\< Groups \< Elements \< F!eferjkes
o —— —

Because Cranium and Synapse’s user Motrand + oty bencoate
interface is analogous to a printed Composiion/Temperatre Dependent Secton
reference book, navigation typically e g Data Vahes

o o Temp X,1: Methanol X,2: Methyl benz... X, 3 Data
consists of changing chapters and c gL wx [ owe |l gem
. 1 |25.000000 1.139754 98.860246 --- 1.079600 ~
t u r n I n g p a ges . 2_ 25.000000 2.315391 97.684608 --- 1.075650
3_ 25.000000 5661916 94.338084 --- 1.062800
4_ 25.000000 8.180155 91.819845 --- 1.052870
? 25.000000 12.531266 87.468734 --- 1.036790
6_ 25.000000 13.723549 86.276451 --- 1.032550
?_ 25.000000 19.354953 80.645047 --- 1.013270
z 25.000000 26.139242 73.860758 --- 0.990820 v
< >
1.08E+0 iy
- |
Pages 1. 05E+0 — ‘
= 1.02E+0 — |
\EM" —— 1§ 9

| ( Page: 1 of 438 ) BM: - - -

v
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Navigation: Changing Chapters

# MKS Core Knowledge Base - Internal.mkskbd

To change to a different chapter

Summary \< Chemicals Mixtures \< Techniques \< Groups

simply click the left mouse button on

|Methanc:-l + Methyl benzoate

the chapter’s tab.

Components Section

Click the left mouse button on the

chapter’s tab
B MKS Chemical Design Examples - Work mkscdd ==
Summary \< Functions \< Graphicals Ccnmhinalon'és \< References

IExampIe Combinatorial Chem Design 001

Source Knowledge Base Section

Molecular Knowledge Systems 2018-11-28
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Navigation: Changing

From within a chapter, changing to a
new page can be done using menu
commands, toolbar buttons or
keyboard shortcuts.

Pages

Go To Mixture

Attribute

Identifier

Entities

(x)-Malic acid + Water
1,2-Propylene glycol + Water
1,4-Dioxane + Water
1-Butanol + Ethanol + Water
1-Butanol + Water

0| 1

1-Hexanol + Water
B MKSTest - MKS Core Knowledge Base - Internal.mkskbd 1-Octanol + Water
File Edit Navigation Bookmarks Commands Window Options He 1-Propanol + Water
0| Page Forward Ctrl+F | 2,2-Dimethyl-1,3-propanediol + Water
Page Back Ctrl+B
- 2-Aminoethanol + Water
First Page Ctrl+1 2-Butanol + Water
Last Page Ctrl+0 2-Propanol + Water
Acetic acid + n-Pentyl acetate + Water v
MNext Value... — R
Previous Ctrl+R
Goto... Ctrl+G
Sort...
Scan ) MKSTest - MKS Chemical Design Examples - Workemkscdd
File Edit Navigation Bookmarks Commands Window Options Help

w4+ =|B |

Molecular Knowledge Systems

2018-11-28
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Navigation: Menu Commands and Shortcuts

Every chapter of every document has a

. . B MKSTest - MKS Core Knowledge Base - Internal. mkskbd
NaV|gat|0n menu. The menU’S File Edit Navigation Bookmag:ks Commands Window Options He
commands allow you to page forward e Bt
and backward through the chapter. (If e ol
ast Page trl+
the chapter has no pages or only one Next Value..
page then most commands will be o
disabled.)
Associated with many menu
commands is a keyboard shortcut \ Keyboard Shortcut

shown to the right of each command.
Menu Command

Molecular Knowledge Systems 2018-11-28




Navigation: Toolbar Buttons

The toolbar contains four navigation
buttons enabling. Simply pressing the
button will run the navigation
command.

Toolbar buttons may be disabled if
the navigation operation cannot be
performed, e.g., you cannot go back
one page if you are on the first page
of the chapter.

B MKSTest - MKS Core Knowledge Base - Internal. mkskbd

File Edit Mavigation Bookmarks Commands Window Options Help
D[Sl < b M+ =B

\\ Go to the last page
Go forward one page
Go back one page

Go to the first page

Molecular Knowledge Systems 2018-11-28
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Navigation: Go To Entity Dialog

The Go To Entity dialog gives you the
ability to change to any page within
the current document. You can
select the page using the entity’s
name or, depending upon the
entity’s type, another attribute.

For example, the Go To Dialog for
the Chemicals chapter enables you
to select by name, formula,
synonym, etc.

/ Entity’s attribute to display

Go To Chemical

Attribute

Identifier

Entities

/

1,2,3-Trichlorobenzene
1.2 4-Trichlorobenzene
1,3,5-Trichloro-2,4 §-trifluorobenzene
1,3,5-Trichloro-2,4,6-rinitrobenzene

Matching entities

Attributes must contain these

/ substrings

Match Substring

Trichloro

/

||benzene

Cancel

Notes

Molecular Knowledge Systems

2018-11-28
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Navigation: Scan Dialog

The Navigation Menu’s Scan
command activates the Scan Dia
This dialog will page forward
through the current chapter
displaying each entity.

The speed at which pages are
turned can be controlled by the
dialog’s slider control.

Speed control -

log.

s

=TEs

Summary / Chemic... Y Mixtures Y Techniq...Y Groups Y Elements Y Referen...

I4—(4—Methoxyphenyl}—?—butanone

Descriptive Information Section

Formula: |C11H1402

CAS #: |104-20-1

Beilstein: |— --

EC# |203-184-2

RTECS #: |EL9085500

Merck: |— --

Synonyms Section

Anisylacetone
FEMA Number: 2672
Flavis Number: 7.029

AW =

Scanning

)

Slow

\|$| Page: 175 of 2548

| BM: - - -

Fast

Molecular Knowledge Systems

2018-11-28

Each page of the current
chapter is shown
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Navigation: Next Value Dialog

The Navigation Menu’s Next Value
command activates the Next Value
dialog. This dialog enables you to go
forward or backward to the next entity
that has a value for the selected
property.

MNext Property Value Dialog

Properties

Application

Autoignition Temperature

Azeotrope, Maximum Boiling
Azeotrope, Minimum Boiling

Beilstein Number

Biochemical Oxygen Demand, 20 Day
Biochemical Oxygen Demand, 5 Day
Bioconcentration Factor

CAS Number

Chemical Family

Chemical Oxygen Demand, Dichromate
Chemical Ovvnen Nemand Paermannana te

okmark

Scan

Stop

Value Status Scan Speed
Active . I

Pressing the Next button will display
the next chemical that has a value
for the normal boiling point.

Molecular Knowledge Systems

2018-11-28
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Adding and Deleting Pages

B MKSTest - MKS Core Knowledge Base - Internal.mkskbd

TO add a nEW entity tO a documentls gITEEditCiaI]:rijg:zijn Bookmarks Commands Window Options Help
chapter you simply insert a new, blank  Delete Gurent Page CutsD

. Add New\Page Ctrl+A
page and then enter the entity’s Dup,icatecgrem,,age

information on that page. e

Adding and deleting pages can be Sctctpad._\___ ColsShtss

done using Edit menu commands, \ Add and delete pages using the
toolbar buttons and keyboard Edit Menu’s commands

shortcuts.

& MKSTest - MKS Core Knowledge Base - Internal. mkskbd

Eile Edit MNavigation Bookmarks Commands Window Options Help
D& <M +=—|8B|

\\ Delete the current page
Add a new blank page

Molecular Knowledge Systems 2018-11-28




Editing Property Values

Click the left mouse button on a
field, table or graph to edit its

/ associated property.

After add|ng a new page you must ¥ MKS Chemical Design Examples’. Workmkscdd

ESREOE "%

enter property Values- Property Values Summary Yigpétllons Graphicals \<Combinatori...\<References

are displayed in fields, tables and |

g ra p h S . Source Knowlodan Baca Sactinn

To edit any of these property values,

Design Stny

simply click the left mouse button on
the field, table or graph.

The application activates a data

entry dialog tailored for the

Enter Design's Identifier (Modified)

|dentifier

? X

|R134a Replacement Design

Source Information

Reference: ‘MKS Calculation or Derivation

C%ments:

)Zﬂec 03, 2018 at 19:21:58 - MKS001
Value entered.

Save

Cancel

List

Date Show Ref

Phrase

Set

property being edited.

Molecular Knowledge Systems 2018-11-28
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Data Entry Dialogs

Dialogs used for editing values typically
have commands tailored for the
particular property being edited. In
addition, these dialogs perform
numerous checks to ensure the values
being entered are valid.

Values for the temperature,
pressure and composition

Enter the Mixture's Density, Liquid - f(T,P,X) ? X
Composition (in original units) Units: mol frac ~
Methanol B3[0.2083 |+ | -
|n—ButyIamine \ X: \0.501? \ + \ \
= x -
W
Molality/Molarity, Solvent Molarity, Solution Density
n-Butylamine kg/m3
Datum (in original units)
Temp: ‘298-15 ‘t‘ | Units: K ~
Pres: ‘159-6 ‘ + ‘ | Units: | bar v
VAlue: (0777200 | £|0.0001 | Units: | glem3 v
ource Information
OK
Reference: ‘Papaioannou + Bridakis + Panayiotou (1993) ‘ List
OK & Next
Comments: Cancel
Jul 16, 2013 at 12:45:05 - MKS001 Date
Value entered.
Phrase X Default
Set X Total
Show Ref

are check for validity.

Tailored commands for each property. /

Molecular Knowledge Systems

2018-11-28

19




Editing Special Characters

Special characters can be
entered into an edit control
by clicking the right mouse
button and selecting the

Click the right mouse button in

an edit control and select the

/ Insert Symbol command.

Enter Reference's ldentifier 7 * |
Identifier
Valén + Lopez + Urieta + Rovo + Lafueng (2002) Default
Insert Symbol... I

Source Information

Reference: |MKS _ [ List
Insert Symbol menu Comments 04y e

Value entered. Sel I J K L M NOPQRSTUVWXY Z [ \
Command' ' b ¢c d e f g h i j k I m n o p
vwxyz { |}~ i¢£m ¥
" - ® o+ 2 3 o oq - 10
AAAAAAAEACEETEE T I I
O 00O x @ U UVUUUY P B a a a
e eé & é i i 1 1 6 n o 6 6 o o
i vy pv Aa A a AagC ¢ C ¢ ¢C
D dE & E ¢ EfJE ¢ E &6 G g G
The application activates the Symbol oo i ' ' | ' ' _
dialog. Select a special symbol for | - i & & Gancl

insertion into the edit control.

Molecular Knowledge Systems

2018-11-28
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Editing All Data

It is very common that multiple

\ Select the Edit All Data command

A green triangle in a
field’s upper right
corner indicates that
additional data is
available for the
property.

to add property values having
different status.

. ) ¥ MKS Core Knowledge Base - Internal.mkskbd
values are available for a property’s ——
value. For example, many [Enane
researchers have measured the “T"“’"“"""" Secten .
ope . Data
boiling point of acetone. e lor oo :
Click the right mouse button in a : r
. . Ve: |0.145500 Edit Al Data h
field and choose the Edlj[ All Data o [ K
command to enter multiple e
property values. ]
Tne [ .. [_]
Molecular Knowledge Systems 2018-11-28
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Editing All Data

/ Edit property values.

Cranium and Synapse can store PR / - |
property values having four status St /';;j:
values: active; passive; rejected; 1 =TT y =
unknown. T I
Click the right mouse button on a - , | ogmems
field or table and select the Edit All et Drim e s e Comen i Fows
Data command to activate the Edit Sttsios
All Data dialog. This dialog enables ol
you to enter property values and set

their status.

Press the status button to change the
status of the selected data to active,
passive, rejected or unknown.

Molecular Knowledge Systems 2018-11-28 22




Copying and Pasting Values

Property values must often be
copied from one application and
pasted into Cranium or Synapse.
Clicking the right mouse button on a
field, table or graph activates a
commands window the provides
several copy and paste commands.

Click the right mouse button to active

& MKS Core Knowledge Base - Internal.mkskbd == FO
,_" Summary / Chemicals \< Mixtures \< Techniques \< Groups \< Elements Y Referem:es\
|Elhanc
Temperature Dependent Section N

Property: |Densiry. Liquid - f(T)

Data Values

C kg/m3
-173.150000 641.717856 -
-168.150000 636.236095
-163.150000 630.706222 Edit Al Data...
-159.750000 623.600000 Edit Data..
-158.150000 625.236489 Compile Values..
-153.750000 617.100000 Internet Search..
-153.150000 619.508154 Copy Special..
-149.950000 610.500000 Copy Data
1A% 1 RNNMNN R13 0RT Paste Special... v
Paste Data
B.42E+2 L Clear Special...
l- Clear All Data
B8.12E+2 l Clear Data
a [ ] Cut Data

. . _—E
a menu contalnlng copy and paste —T ®. ’.
commands.
Molecular Knowledge Systems 2018-11-28 23




Copying and Pasting Values

Values must often be pasted in a very

Required Attributes

specific order. For example, liquid Temperaure; Dot >

denSity mUSt be entered aS Set Of Click Column Heading to Map Attribute

temperature, value pairs. EEE— —— T — T

The Paste Special menu command 2| cotamis et g x|

activates the Paste Special dialog that T ——
Temperature® Cancel

86

104
122
140
158

enables you to associate attributes with
different data columns.

Uzle[=[>]=]a]=[=]~]=

Use the Paste Special functionality to
associate attributes with specific

columns of data values.

Molecular Knowledge Systems 2018-11-28

Temperature Accuracy
Datum Accuracy
Reference

Comment
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Scratchpad Dialog

Sometimes copied values
must be significantly
rearranged before they can
be pasted. The Edit menu’s
Scratchpad command
activates the Scratchpad
dialog that provides
functionality for values
rearrangement.

Scratchpad Dialog

Data Values

<

Text Delimiters
| Tab Space []Comma

Semicolon [ ]Period

01 02 03 04 05 |

1 | 42.264 376.347

12 | 42.250 376.335

'3 | 51.080 489,000

4| 51.076 489,029

'5 | 51.000 489.001 -

'8 | 51.081 .
17 | 58.467 601.034 -
'8 | 58.304 600.886

ry 64.962 720.501
0] 64.907 720.200
11]- 64.889 719.912
2] - 64.868 717.043
13]- 64.860 717.024
[14] - 6.442 962.158
15 - 962.054
6] 962.152

Paste Delimiter Options

[JProcess consecutive delimiters as one

Edit

Replace

Clear

Clear All

Undo

Cut
Copy

Paste

Transpose
Function
Statistics

Regress

Add Rows
Add Columns

Use the Scratchpad Dialog to rearrange
data values before pasting.

Molecular Knowledge Systems
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Choosing Units of Measure

Select the Set Units command from the
Options menu to assign units of measure. \

Data values are stored in their original

B MKSTest - MKS Core Knowledge Base - Workmkskbd

unlts, However’ the un'ts |n Wh'Ch File Edit Navigation Bookmarks Commands Window Options Hglp

. o o 0| = | | | B | Set Data\Folder...

values are displayed are specified by Number Rormat..

the user. Set Unts..

Selecting the Set Units command from Set Property Unit » %

the Options menu will activate the Set Property

Property Units dialog. Select the et e KD .

) . : | t

property and its desired units of Units electa
g/em3 A property

measure. T and its
T sdunits | | desired
v units of
_“ ol measure.
Ib/in3 v

Molecular Knowledge Systems 2018-11-28 26




Number Formatting

The format of displayed numbers, e.g.,
the number of decimal places, is
changed by selecting the Number
Format command from the Options
menu.

The Number Format command
activates the Number Format dialog
enabling you to choose the number of
decimal places and exponent digits in
displayed values.

Select the Number Format command to

change the format of displayed values. \

B MKSTest - MKS Core Knowledge Base - Work.mkskbd
File Edit Navigation Bookmarks Commands Window Options Help
D= | B Set Data Folder...

Number Format..

y

Set Units...
MNumber Format Dialog ? bd
Options
i
Decimal Places: |6 ~
Cancel
Exponent Digits: |2
Sample
1.234568E+00

Molecular Knowledge Systems

2018-11-28
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Printing

Each document provides commands
for page setup, print preview and
printing. A standard report format is
used to print data, estimates,
molecular structure, graphs, etc.

When the Print command is selected
from the File menu, the application

will request the sections to be printed.

Print Sections Dialog

Sections to Print

Applications
Families
Chemical Structure
Structural Properties: Estimated
Constant Properties: Active
roperties: Estimated
Critical Properties: Active
Critical Properties: Estimg
Triple Point Properties: Active
Triple Point Properties: Estimated
Thermodynamic Properties: Active
Thermodynamic Properties| Estimated
Phase Transition Enthalpies: Estimated
Phase Transition Enthalpies; Active
Optical Properties: Active

? >

Cancel

All

None

Options

First select those sections who
values you wish to print. Pressing

the OK button will print the

selected sections.

Molecular Knowledge Systems
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[ ] [ ]
P r I I lt I I l g # MEKS Core Knowledge Base - Work.mkskbd

i Print.. § NextPage Prev Page Two Page Zoom In

(£}-1-Phenylethanol

Selecting the Print Preview o

Value Referen

FEMA Number: 2685

command will also activate the Print

Methyl pheny cabinol

Section dialog. However, selecting S—

the desired sections and pressing T —
the OK button will not print those

sections. Instead a preview of the

printed page will be displayed in the S
document’s window.

1) SgmaAldich Chemicd Catabg.” .

Hemi phere Publishing Corpomstion. Washington, DC, USA. Year 1352,

2 T.E. Deubert and R P. Danner. "Phy sical and Thermodynamic Properties of Pure Chemicals.”

Page 1of1
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Questions or Comments

info@molecularknowledge.com

www.molecularknowledge.com

Thank You

Molecular Knowledge Systems 2018-11-28
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